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Description: ANDVSA_v4.0 
This guide is meant to provide a broad understanding regarding how to install and use the latest release 
of the ANDVSA database. There are some critical changes concerning how the ANDVSA database inputs 
data and how it can report that inputted information. Those changes are covered in this documentation. 
 
Among the most critical of changes within ANDVSA_v4.0 are the following: 

1. The Service Provided report should be the ONLY canned report that victim service programs are 
using to report statistics to any other body 

a. The Services provided report will ignore participants that have no AGE entered. This 
only affects the Individual Participants count. 

2. The Date of Incident is now a required field of data and must be linked on Tab 4 with services 
provided (see page 34) 

3. The dropdown list on Tab 4 which shows all service months that a participant has utilized 
services is now working properly 

4. With the release of ANDVSA_v4.0 an update query called “JoinServicestoIncident.mbd” will 
need to be run on every data entry machine – this query links incident information to services 
provided. 

 
Please review this documentation carefully, as it covers the key areas of usability and the many 
functions of the ANDVSA database. For specific questions regarding data fields, your victim service 
program should have a document called “A Guide To Forms: CDVSA Data Definitions and Recommended 
Recordkeeping Practices.” If you cannot locate a copy of “A Guide to Forms,” or if you are in need to 
aspects and concepts not covered in this document as they pertain to the ANDVSA database, please 
contact CDVSA’s Research Analyst: (907) 465-4673.  
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ANDVSA database: General Rules and Information  
As a general rule, victim service staff in charge of inputting data into the ANDVSA database should keep 
these aspects of the ANDVSA database in mind: 

1. The ANDVSA database is made up of two components: 
a. ANDVSA_v4.0.mdb: This is typically referred to as the “front-end” of the database 

application. It is the interface that victim service staff use to input data that is 
tracked on the Participant Information, Incident Information, and Service Provided 
forms. 

b. database_version_10-07_be.mdb: This is typically referred to as the “back-end” of 
the database, this is where all the inputted data actually is stored. 

c. Both of these files must be stored in the following directory C:\database (i.e., the 
root of the data entry machines “C:” drive” –  do not change the name of 
“database” folder as this will cause the ANDVSA database not to work properly. 

d. Typically, when updates (like ANDVSA_v4.0) are released, the updates ONLY effect 
the front-end of the database – meaning that no previously entered data will be 
affected within the “database_version_10-07_be.mdb” file. 

2. When entering data into the ANDVSA Database these general rules should be followed: 
a. Do NOT enter participant information in an “assembly-line” fashion. Work with one 

participant at a time and enter in all of their associated information before moving 
onto another participant 

b. Always conduct a search of the database if you are unsure whether or not a 
participant is returning to prevent duplication 

c. Always input into the ANDVSA database as much information as possible, but when 
circumstances prevent comprehensive data input the following are absolutely 
required when entering participant information: 

i. Participant ID (Assigned by the victim service program) 
ii. Date of Contact 

iii. First or Last Name or Anonymous Contact 
iv. Date of Birth or Approximate Age 
v. Gender (i.e., Male, Female, or Other) 

vi. Participant Type (Primary, Secondary, or Other) 
vii. Primary Issue (Domestic Violence, Sexual Assault, Stalking, or Other) 

viii. Date of Incident (at least the year of the incident will suffice) 
ix. Service Month(s) 
x. Utilized Services (tracked on the  Service Provided form) 

d. On Tab 4 (Services) always be sure to link the appropriate incident information with 
the services provided (see page 34) 

3. The ANDVSA database must be on a machine without access to a network or the internet 
4. Do not change any tables or fields within the “database_version_10-07_be.mdb” file as this 

will cause the ANDVSA database application to not work properly, if at all. 
5. Perform monthly backups of the C:\database folder to protect your programs data 
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Section One: Installing ANDVSA_v4.0 
 

1. Located the .zip file called “ANDVSA_v4.0.zip” that was attached to an email sent out to victim 
service EDs and Data Entry Staff (Dated May 21, 2010) by the CDVSA Research Analyst 

2. Download (i.e. save) the “ANDVSA_v4.0.zip” file to your desktop 
3. Once you’ve downloaded the “ANDVSA_v4.0.zip” file to your desktop, locate it 
4. Right-Click the “ANDVSA_v4.0.zip” file (See Figure 1), Highlight “Open With” and then click 

“Compressed (zipped) Folders” 
Figure 1 

 
5. A window like Figure 2 will appear, Click “File” and select “Extract All” 

Figure 2 
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6. A window like Figure 3 will appear, Click “Next” 
Figure 3 

 
7. A window like Figure 4 will appear, Click “Browse” 

Figure 4 
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Figure 5 

 
8. A window like Figure 5 (Above) will appear, Click on “Desktop” and hit “OK” 
9. You will now be at the window like Figure 6, Click “Next” 

Figure 6 
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10. You will be now at a window that looks like Figure 7, Uncheck “Show Extracted Files” and click 
Finish 

Figure 7 

 
 

11. You should now have a Folder called “ANDVSA_v4.0” on your desktop (See Figure 7) 
Figure 8 

 
12. You need to save the “ANDVSA_v4.0” onto CD or a USB thumb drive so you can put it on your 

data entry computer 
a. To Copy to CD: 

i. Put a blank CD into your CDRom Drive 
ii. Right Click the “ANDVSA_v4.0” folder (See Figure 10) Figure 9 

Figure 10 
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iii. Select “Copy” from the drop down menu 
iv. After you’ve selected “Copy” from the drop down menu, locate the Icon “My 

Computer” and double-click it to open it (See Figure 11) 
Figure 11 

 
v. You should now be at a window that looks like Figure 12 (yours will look 

different than mine), Double-Click your CD Drive to open it 
Figure 12 

 
vi. You should now be at a window that looks like Figure 13, Right-Click in the white 

space and select “Paste” 
Figure 13 
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vii. You should now see something like Figure 14, Click “File” and select “Write 
These Files to CD” 

Figure 14 

 
viii. A window like Figure 15 will appear, Name the CD “ANDVSA Installer” and click 

“Next” 
Figure 15 
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ix. You will now see a window and progress bar like Figure 16, wait for the 

“ANDVSA_v4.0” copy to the CD 
Figure 16 

 
x. After the computer is done copying the “ANDVSA_v4.0” to the CD it should 

automatically pop out of the CD Drive tray 
xi. You should now be at a window that looks like Figure 17, Make sure that “Yes, 

write these files to another CD” is unchecked and click “Finish” 
xii. You can now label the CD you just made and take it to your data machine 

b. To Copy the “ANDVSA_v4.0” folder to a USB drive: 
i. Right-Click the “ANDVSA_v4.0” folder 

ii. Select “Copy” from the drop down menu 
iii. On your desktop locate the icon called “My Computer” and double-click it to 

open it 
iv. You should see your USB drive in the list of drives, Double-click your USB Drive 

to open it 
v. In the white space within the window open for your USB Drive Right-Click and 

from the drop down menu select “Paste” 
vi. You should see a little window that pops us that shows that the computer is 

transferring files onto the USB drive 
vii. When it is done copying files to the USB drive you can remove the USB Drive 

and plug it into your data entry machine 
13. OK, deep breaths. You should now have the “ANDVSA_v4.0” folder on USB or CD 
14. Copy the “ANDVSA_v4.0” folder that you have on USB or CD to the desktop of the data entry 

machine  
15. After you’ve successfully copied the “ANDVSA_v4.0” folder the desktop of the data entry 

machine, double-click the “ANDVSA_v4.0” folder located on your data entry machine’s desktop 
to open it 
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16. You should now be at a window that looks like Figure 17, Right-Click the file 

“ANDVSA_v4.0.mdb” and select “Copy” from the menu (NOTE: because of your view settings 
you might not see the “.mdb” part of the file name – THIS IS OK) 

Figure 17 

 
17. Now you need to go to the desktop and locate the icon called “My Computer” double-click it to 

open it 
18. You should now be at a window that looks like Figure 18, double-click your “C:” drive to open it 

(NOTE: my “C:” drive is called “pkback# 001” yours will be named DIFFERENTLY, just make sure 
you open the drive that is labeled with the letter “C”) 

Figure 18 
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19. You should now be at a window that looks like Figure 19, locate the folder called “database” and 

double-click it to open it 
Figure 19 

 
20. You will now be at a window that looks like Figure 20 (NOTE: You may have more files and 

folders in the “database” folder than I do – this is okay!) 
Figure 20 
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21. Within the “database” folder window, right-click in the white space highlight “New” and then 

click “Folder” (See Figure 21) 
Figure 21 

 
22. Name the Folder “Backup [date]” Use any date format, just use today’s date (See Figure 22) 

Figure 22 
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23. Now I need you to drag-and-drop all of the files and folders you see in the “database” folder into 
the “Backup [date]” folder you just created EXCEPT the file called “database_version_10-
07_be.mdb” as in Figure 23 (Remember the ‘.mdb” part of the file name may not appear for 
you, just be sure you leave the file “database_version_10-07_be” out of the “Backup [date]” 
folder you  just created” 

Figure 23 

 
24. Now that you’ve dragged and dropped all of the files and folders within the “database” into the 

“Backup [date]” folder you created you should only have two items showing in the “database” 
folder window: 1) “database_version_10-07_be” and the “Backup [date]” folder.  

25. Now right-click in the white space within the “database” folder window and select “Paste”, See 
Figure 24 

Figure 24 
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26. You should have now copied the “ANDVSA_v4.0.mdb” file into the “database” folder window as 
shown in Figure 25 

Figure 25 

 
27. Now we need to create a shortcut to the new database file “ANDVSA_v4.0.mbd” that you just 

copied into the “database” folder 
28. Right-click the “ANDVSA_v4.0.mdb” file and select “Copy” from the drop down window (See 

Figure 26) 
Figure 26 
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29. Now go to the desktop, Right-click on an empty space on the desktop and select “Paste 
Shortcut” (See Figure 27) 

 
Figure 27 

30. You should now have an icon called “Shortcut to ANDVSA_v4.0.mdb” on your desktop 
31. Double-click the “Shortcut to ANDVSA_v4.0.mdb” icon 
32. The ANDVSA database should start up  
33. You’ve now installed the latest version of the ANDVSA database - nice work! 

 

Final Notes: 
Please call the CDVSA Research Analyst – (907) 465-4673 – if you run into any difficulties or are in need 
of clarification. If you cannot locate the latest ANDVSA_v4.0 database application, please call the CDVSA 
Research Analyst to procure a copy. 
 
 
 
 
 
 

Next Section: 
Data Entry & Navigation Techniques 
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Section Two: Data Entry & Navigation Techniques 

A word about data entry:  
The database is designed to accommodate entry of one program participant record at a time. Programs 
are discouraged from entering data in an “assembly-line” method (for example, entering all of the Tab 
One information for 20 records, then all of the Tab Two information, etc.), as doing so greatly increases 
the possibility of operator error.   

Required data fields:  
On screens for which there are required data elements, these elements are listed.  In the example 
below, the large red circle indicates a list of required information for the current screen. This 
information corresponds to fields marked with a blue asterisk on the screen.   
 

 
Figure 28 

 
Users can switch between tabs before completing data fields; however, on tabs with required data 
fields, all required data must be entered. An error message similar to the one below will appear if the 
required fields are not completed.   

 
Figure 29 
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Prompts & Data Field Descriptors:  
When the cursor is in a field, an additional description of data requirements for that field will appear in 
the gray bar at the bottom of the screen (see figure below).   
 

 
Figure 30 

Database Navigation Tips:  
Users are able to access between 85 - 90% of the database functionality without a mouse.  The five most 
commonly used keystrokes to navigate the database are (1) the “Tab” key to navigate between fields 
within a screen;  (2) the “Alt” key in conjunction with underlined letter or number keys to navigate 
between screens; (3) the “Alt” key in conjunction with the up and down arrow keys to activate a drop-
down box; (4) the arrow keys to navigate within a drop-down box; and (5) the “Enter” key to select a 
category within a drop-down box and move to the next field.   
 

1.) Use the “Tab” key to move between fields within the screen.  In the figure on the next page, 
pressing the “Tab” key will move the cursor from the “First” name field to the “Middle” name 
field. Pressing “Tab” again will move the cursor to the “Last” name field, and so on.  

 
2.) Use the “Tab” key together with the “Ctrl” key to move between tabs on the Victim Services 

Data section of the database.  
 

3.) Use the “Enter” key to dismiss dialogue boxes or make a selection.  
 

4.) Use the “Alt” key together with an underlined character to activate buttons:  
 

o  To navigate from “Tab 1: Program Participant Information” to “Tab 2. Demographics,” 
hold the “Alt” key together with the “2” key.  In Figure 31, the red oval indicates a Tab 
that can be accessed using the “Alt” key in conjunction with an underlined character.  In 
this case the numeral “2” is underlined.  
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o To delete this record from the screen below, press the “Alt” key together with the “D” 
key. In Figure 31, the blue oval indicates a function that can be accessed using the “Alt” 
key in conjunction with an underline character.  In this case the letter “D” is underlined.   

 

 
Figure 31 

 
5.) Use the “Alt” key along with the down arrow to view drop-down menus.   

 
6.) Use the up and down arrow keys to navigate within a drop-down menu.  Arrow keys can also be 

used.  
 

 
Figure 32 
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7.) Use the “Enter” key to make selections from a drop down menu.  This should move the cursor to 

the next data field. The same holds true for radio buttons.  
 

Limitations:  
Although every effort has been made to allow users to access data entry functionality without use of a 
mouse, there are some cases in which users must use a mouse to make a selection.  For example, in the 
Search Participant dialogue box (see figure below), users can enter search data via keyboard and then 
use the “Tab” key to move to the “Search” box, and the “Enter” key to activate a search. However, in 
order to select a particular record, users must use the mouse to click on the “select” button to the right 
of the selection.  

 
Figure 33 

 
 
 
 
 
 
 
 
 
 
 
 

Next Section:  
Victim Services Data 
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Section Three: Victim Services Data  
The Victim Services Data section of the database is where all Services Provided, Incident Information, 
and Protective Order form data are entered.  A database record should be created for each program 
participant who has an Incident Information, Services Provided, or Protective Order form in their file.   
 
Note that every program participant who has a Services Provided form or a protective order form must 
have a green form on file.  You will not be able to input Services Provided information in the reporting 
database unless the information corresponds to a green form.  
 
If you have questions about when to create a new incident for a program participant, consult the CDVSA 
Guide to Forms. 
 

Victim Services Data Opening Screen:  

 
Figure 34 

 
This screen appears when the “Victim Services Data” button is selected on the database opening screen. 
This is the starting point for entering a new record of a program participant or modifying/adding new 
information to an existing program participant record. 
 
A program participant ID and the date of contact must be entered before you can enter the rest of the 
program participant’s information.   
 
The program Participant ID should be assigned in accordance with the program’s policies and 
procedures.  The reporting database allows for letters, numbers, symbols, and spaces to be used in the 
program participant ID field.  Each program participant ID must be unique.  A message window appears 
if the program participant ID has already been added (see figure 35 – next page).  
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Figure 35 

The date of contact field is programmed to accept dates for month and date in either one or two digits. 
The year must be entered as four digits (yyyy).   
 

 
Figure 36 

Type the program participant ID and a date of contact, then press the “Enter” key.  Tab One will then 
appear.  
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New Program Participant Record: Tab One  

 
Figure 37 

Tab One corresponds to information provided on the Participant Information form.  A first and/or last 
name must be entered for the program participant.  If first and/or last name are unknown, the 
anonymous contact box must be selected.  
 
Program participants who have children who are receiving services should list the ID numbers of their 
children on Tab One. When information is typed into the first child ID box, a new child ID box 
automatically appears (Figure 38).   

 
Figure 38 

Click on Tab Two - Program Participant Demographics to continue.  You may also press Alt + 2 to 
navigate to Tab Two, or Tab + Ctrl.  
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New Program Participant Record: Tab Two  
 

 
Figure 39 

Tab Two corresponds to information provided on the Program Participant form.  A date of birth or 
approximate age must be entered to meet federal reporting requirements.  If an approximate age is 
entered, a date of birth will be calculated based on the current year.  January 1 is the automatic day and 
month for all date of births calculated from an approximate age.   
 
Figure 40 shows that a date of birth is calculated as 1/1/1988 when an approximate age of 18 is entered.  

 
Figure 40 

If the approximate age is then cleared manually, a new message window appears to inform you that the 
date of birth has been changed (Figure 41). 
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Figure 41 

The “Clear age AND Date of Birth” button prevents this error message from appearing.  

 
Figure 42 

• A female, male, and unknown/other gender radio button must be selected for each program 
participant record.  
 

• Check any race/ethnicity that applies to the program participant.  More than one box may be 
selected.  
 

• Community of residence may be typed if known. According to federal reporting guidelines, 
Anchorage and Fairbanks are considered urban.  All other parts of Alaska are rural.  

 
The three demographics questions can be answered if known.  These questions may be left blank. If a 
radio button is pushed erroneously, press the “clear” button to unselect the radio button. The “clear” 
button will unselect information for the field.  It does not clear all of the information on the screen.    
Click on Tab Three – Incident & Perpetrator Information to continue. 
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New Program Participant Record: Tab Three (Incident Information)  
 

 
Figure 43 

Tab Three corresponds to information provided on the incident information form.  A program 
participant type must be selected and a program participant primary issue must be selected from the 
drop down menus (see Figure 44).   
 

 
Figure 44 

If either the program participant type or the program participant primary issue is not selected, a 
message window will appear (Figure 45).  
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Figure 45 

Choosing to select “Other” in either of these fields will cause underreporting and should be avoided. 
 
Select all issues that apply in the “Other Issues” field that are not the same issues already marked under 
the primary issue. 
 
A date of incident in the ANDVSA_v4.0 database application is required and should not be left blank. If 
you leave the date of incident information blank you will not be prompted to fill it in, but by leaving this 
field blank you risk under reporting. Leaving the date of incident field blank should always be avoided. 
 
Complete the remainder of the incident information fields.  If a radio button is pushed erroneously, 
press the “clear” button to unselect the radio button.  The “clear” button will unselect information for 
the field.  It does not clear all of the information on the screen.  
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New Program Participant Record: Tab Three (Perpetrator Information)  
 

 
Figure 46 

The perpetrator information at the bottom of Tab Three should be completed if known.  A first name or 
last name or nickname may be entered in the Name field.  The Name field can be left blank. A new 
perpetrator box appears when information is typed into any field in the perpetrator box. If a perpetrator 
is added erroneously, click the “Delete Perpetrator” button (see red box in Figure 46 – next page).  
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Figure 47 

 
Clicking the “Delete Perpetrator” button causes a message window to appear (see figure below).  Click 
“Yes” if the perpetrator needs to be deleted.  IMPORTANT NOTE:  Information is permanently deleted 
once the “Yes” button is clicked.  

 
Figure 48 

 
Click on Tab Four – Services to continue.   
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New Program Participant Record: Tab Four (Services Provided) 
 

 
Figure 49 

 
Tab Four corresponds to information provided on the Services Provided form.  A month and year must 
be added to this form.  Type a month and year in the “Reporting Period (month/year)” field (see red box 
in figure below). The month and year will automatically appear in the “Go to this report” field (see blue 
box below) when the “Save Report” button is selected (see green box in Figure 50).  
 

 
Figure 50 

You cannot add a new services form with a month/date that already exists in the program participant’s 
record. A message window appears if the month/date have already been added (Figure 51).  
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Figure 51 

 
The month/year reporting period field cannot be left blank.  A message window appears if the 
month/year is left blank (Figure 52).  

 
Figure 52 

In ANDVSA_v4.0, Tab 4 service data must be linked to the most recent incident information entered for 
a program participant. This information appears in the gray box in the lower right hand portion of Tab 4. 
(See Figure 53) 
 

 
Figure 53 

How to use the Incident Information (Gray Box) on Tab 4: 
• When creating a new participant, an incident must be created before it can be linked to services 

provided. Create an incident, save the record, and then move to Tab4 to edit services provided; 
press the Refresh button in the Incident information box to populate the drop-down list of 
incident dates. Select the date of the corresponding incident and press the Link button. 
 

• When editing an existing participant record, incident information can be changed from the gray 
box area. After making changes to the incident information, press the Update Incident button to 
save the changes and have them applied to the incident record. This prevents data entry 
personnel from being required to change incident information on both Tab3 and Tab4. Any 
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changes made on Tab4 in the Incident Information section will be reflected on Tab3 and changes 
made on Tab3 will be reflected on Tab4 after the Refresh button has been pressed. 
 

• To change the incident associated with a services provided month, press the Unlink button first 
in the Incident Information section. Use the drop-down list to select the correct incident date 
and then press the Link button. 

Tab4 Incident Information (Gray Box): Important Note 
The gray box of incident information on Tab4 must be filled out and linked for every participant. If you 
do not link incident information with services provided, you risk under or incorrect reporting of entered 
data. Always fill out and link incident information within the incident information gray box on Tab4. 
 
Services Provided form totals must be entered into the corresponding fields.  The numbers may be 
saved and changed, which allows for data to be entered more than once, if desired.  The totals fields for 
fields 3-28 are limited to numbers between 0 and 31.  A message window appears if fields 3-28 have a 
number greater than 31 (See Figure 54).  
 

 
Figure 54 

Hovering definitions appear when a mouse pointer passes over a services field.  The red box in the figure 
below is the area over which a mouse pointer can pass in order for the hovering definition (see blue box 
in Figure 55) to appear.  
 

 
Figure 55 
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Either “Program Participant Fully Served” or “Program Participant Partially Served” must be selected to 
meet federal reporting requirements.  A message window appears if neither is selected (Figure 56).  

 
Figure 56 

 
“Other Referral Made” must be checked if a program makes a referral to alcohol or drug treatment, 
medical intervention, law enforcement, or batterers’ intervention.  This must be documented 
anonymously.  CDVSA and ANDVSA recommend use of CDVSA Partial Service and Referrals form for this 
purpose.  
 
Click on Tab Five – Protective Orders to continue.  
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New Program Participant Record – Tab Five (Protective Orders) 
 

 
Figure 57 

Tab Five corresponds to information provided on the Protective Order Report.  A date of report must be 
entered (see red box in figure below). The month and year will automatically appear in the “Go to this 
report” field (see blue box below) when the “Save Report” button is selected (see green box in Figure 
58).  

 
Figure 58 
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More than one protective order can be added for a participant within a given month.   
 
The month/year reporting period field cannot be left blank.  A message window appears if the 
month/year is left blank (Figure 58).  

 
Figure 59 

Complete as many fields as possible.  If a radio button is pushed erroneously, press the “clear” button to 
unselect the radio button.  The “clear” button will unselect information for the field.  It does not clear all 
of the information on the screen.  
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Searching for Program Participant Records  
There are two ways you can find a program participant record.  One way is to use the “Search for 
Program Participant” button in the header of the Victim Services Data section (see the red oval in Figure 
60).  
 

 
Figure 60 

A new window will appear labeled “Search for Participant.” Enter all or part of a program participant 
name or program participant ID number in the search field and click on “Search” to generate a list of 
possible matches (see figure below).  Select the program participant record from the list.  
 

 
Figure 61 

The second way to search for a program participant record is to use the “Previous” button (Figure 62 – 
Next page).   
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Figure 62 

Remember, you can also use the “Alt” key together with the “P” key to navigate to the previous record.  
Continue clicking on the “Previous” button or using “Alt” and “P” to view previously entered records.  
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Modifying/Adding New Information to Program Participant Records 
 

 
Figure 63 

Tabs 1 & 2 (Participant Information): 
Any new information may be added to Tabs One and Two.  Any modified information can be 
deleted/cleared and retyped/selected on Tab One.  If new children have received services, type the new 
child ID number into the “Program ID#’s of Participant’s Children” box.  

Tab 3 (Incident Information): 
Any new information learned about the existing incident (on the same green form) may be added to Tab 
Three. Any modified information learned about the existing incident (on the same green form) can be 
deleted/cleared and retyped/selected on Tab Three.  Click the “Save Incident” button (see blue box in 
figure below) to save changes.  
 
If a new incident occurred (and therefore a new green form completed), use the “Add New Incident” 
button to type new incident information (see red box in figure below).  Click the “Save Incident” button 
to save the form before continuing.  
 
If an incident was added erroneously, click the “Delete Incident” button (see green box in Figure 64 – 
next page).  
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Figure 64 

Clicking the “Delete Incident” button causes a message window to appear (Figure 65).  Click “Yes” if the 
incident needs to be deleted.  IMPORTANT NOTE:  Information is permanently deleted once the “Yes” 
button is clicked.  
 

 
Figure 65 

Any modified information learned about the perpetrator in the existing incident (on the same green 
form) can be deleted/cleared and retyped/selected on Tab Three.  Click the “Save Incident” button (see 
blue box in Figure 66) to save changes.  
 

 
Figure 66 
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New information uncovered about additional perpetrators in the same incident can be added.  A new 
perpetrator box appears when information is typed into any field in the perpetrator box.  If a 
perpetrator is erroneously added, click the “Delete Perpetrator” button (see red box in Figure 67).  
 

 
Figure 67 

You should be careful to add perpetrator information to the appropriate incident form.  Use the 
“Previous Incident” button (see red box in Figure 68) and the “Next Incident” button (see blue box in the 
figure below) to locate the correct incident form.  
 

 
Figure 68 

Tab 4 (Services Provided and Linked Incident Information): 
To add a new Services Provided sheet to an existing program participant, find the program participant 
record using the “search” button on the opening screen.   
 
Select the “Add New Report” button (see red box in figure below) on Tab Four. Complete the 
information as described in the New Program Participant – Tab Four section (Page 33).  
 
If a Services Provided form was added erroneously, click on the “Delete Report” button (see blue box in 
Figure 69 – next page).  
 
Clicking the “Delete Report” button causes a message window to appear. Click “Yes” if the report needs 
to be deleted. IMPORTANT NOTE: Information is permanently deleted once the “Yes” button is clicked.  
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Figure 69 

 
You can add/modify information on an existing Services Provided form.  Be careful to add/modify 
information on the database report form that matches the date on the Services Provided form.  Use the 
“Previous Report” button (see red box in Figure 70) and the “Next Report” button (see blue box in the 
Figure 70 to locate the correct services form).  
 

 
Figure 70 



45 | A N D V S A  4 . 0  D a t a b a s e  U s e r  G u i d e  
 

Tab 5 (Protective Orders): 
To add a new protective order form to an existing program participant, find the program participant 
record (see page 39).  Select the “Add New Report” button on Tab Five (see red box in figure below).  
Complete the information as described in the New Program Participant – Tab Five section (page 31).  
 
If a protective order form was added erroneously, click on the “Delete Form” button (see blue box in 
Figure 71).  

 
Figure 71 

Clicking the “Delete Report” button causes a message window to appear (see figure to right).  Click “Yes” 
if the report needs to be deleted. IMPORTANT NOTE:  Information is permanently deleted once the 
“Yes” button is clicked.  

 
Figure 72 
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You can add/modify information on an existing protective order form.  Be careful to add/modify 
information on the database report form that matches the date on the protective order form.  Use the 
“Previous Report” button (see red box in figure below) and the “Next Report” button (see blue box in 
the figure below) to locate the correct protective order form.  
 

 
Figure 73 

Deleting Program Participant Records  
A program participant record can be deleted when any part of the program participant record is 
displayed. Instructions on how to find a program participant record are on page 39.  Click the “Delete 
Participant” button in the header (see red box in figure below) to delete an entire program participant 
record.  
 

 
Figure 74 

Clicking the “Delete Program Participant” button causes a message window to appear (see Figure 75 – 
next page).Click “Yes” if the program participant needs to be deleted.  IMPORTANT NOTE: the record is 
permanently deleted once the “Yes” button is clicked.  



47 | A N D V S A  4 . 0  D a t a b a s e  U s e r  G u i d e  
 

 
Figure 75 

Exiting Victim Services Data Section  

 
Figure 76 

 
Click on the “Close Form” button in the Victim Services header when you want to exit the Victim 
Services section of the reporting database.  You will return to the opening page (see figure below).  
 

 
Figure 77 
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Section Four: Training Data  
The Training Data section of the database is where all training data may be entered.  A new training 
record may be created for each training.  

Training Data Opening Screen/Tab One  

 
Figure 78 

This screen appears when the “Training” button is selected on the database opening screen.  This is the 
starting point for entering new training record or modifying/adding new information to an existing 
training record.  
 
The date of the training, name of the event, and the number of hours of the event should be entered for 
each training session.  
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Enter totals for the number and type of people trained on Tab One.  If a training participant fits more 
than one category, choose the category that best fits the description of the participant’s job.  

Training Data Tab Two and Tab Three:  

 
Figure 79 
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Check all of the training content areas covered during the training on Tab Two and Tab Three.  
Section 4: Training Data Revised July 1, 2009  

Training Data Tab Four and Tab Five:  

 
Figure 80 

Check all of the training content areas covered during the training on Tab Four and Tab Five.  
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Searching for Training Records:  

 
Figure 81 

There are two ways that you can find a training record.  One way is to use the “Lookup Training Event” 
drop down menu in the header of the Training section.  Training events can be sorted by date by 
selecting the “Date” radio button in the red box in the figure above or by name by selecting the “Name” 
radio button in the blue box in Figure 81.  
 

 
Figure 82 

To search for a training record by date, select the “Date” radio button and click the “Lookup Training 
Event” drop down menu (see red box in Figure 82).  Select the training record from the drop down menu 
(see blue box in Figure 82).  
 

 
Figure 83 
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To search for a training record by name, select the “Name” radio button and click the “Lookup Training 
Event” drop down menu (see red box in Figure 83 – previous page).  Select the training record from the 
drop down menu (see blue box in Figure 83 – previous page).  
 
The second way to search for a training record is to use the “Previous Record” button (see red box in 
figure below) and the “Next Record” button (see blue box in the figure below) in the header of the 
Training section.  
 

 
Figure 84 

Deleting Training Records:  
A training record can be deleted when any part of the training record is displayed.  See page 45 for 
instructions on how to search for a training record.  Click the “Delete Record” button in the header (see 
red box in figure below) to delete the entire record.  

 
Figure 85 
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Clicking the “Delete Record” button causes a message window to appear (Figure 86).  Click “Yes” if the 
record needs to be deleted.  IMPORTANT NOTE:  the record is permanently deleted once the “Yes” 
button is clicked.  
 

 
Figure 86 

Exiting Training Section:  

 
Figure 87 

Click on the “Close Form” button in the Training header when you want to exit the training section of 
the reporting database.  You will return to the opening page (Figure 88).  
 

 
Figure 88 
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Section Five: Reports  
The database can produce eight reports. These reports can be grouped into two broad types, Standard 
and Custom Reports.   

 Standard Reports: 
The majority of standard reports are pre-programmed to meet various federal requirements and 
definitions.  The VAWA, FVPSA, VOCA, and Training Reports are examples of these pre-programmed 
standardized federal reports.  Federal regulations and definitions vary considerably and in some 
instances count incidents rather than people.  Because of this, the totals reflected in these standardized 
federal reports may not represent the most accurate demographic data.   
 
The Program Participant Report and the Program Participant with Multiple Incidents Report are 
intended to address this discrepancy and represent correct demographic data. These reports are also 
pre-programmed and standardized.  

Custom Reports: 
The second type of report, the custom report, allows users to control returns by specifying search 
criteria. The Services Provided Report and the Individual Program Participant Report are included in this 
category.  

Critical Note on “Canned Reports:” (*MAY 2010*) 
As of May 2010, with the release of the ANDVSA_v4.0 Database the ONLY canned report that should be 
used to produce reliable statistical analysis should be the Services Provided report. VICTIM SERVICE 
STAFF SHOULD AVOID USING OTHER CANNED REPORTS UNTIL MODIFICATIONS CAN BE MADE TO THE 
OTHER CANNED REPORTS. 
 
To access the reports section of the database, select “Reports” from the Opening Screen.   

 
Figure 89 
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Reports Opening Screen  
This screen appears when the “Reports” button is selected on the database opening screen.  This is the 
starting point for running reports. To run any report, a beginning month and year and an ending month 
and year must be entered.  

 
Figure 90 

The screen above appears when the “Reports” button is selected on the database opening screen.  This 
is the starting point for running all reports.  To run any report, a beginning month and year and an 
ending month and year must be entered.  Months are accepted as 1-12. Years require four digits (yyyy).  
If beginning and/or ending dates are not entered, a message window appears (Figure 91).  

 
Figure 91 
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Services Provided Report  

Purpose:  
The Services Provided Report was created at the request of ANDVSA member programs.  The Services 
Provided Report allows users to view the total number of services provided during a given period. The 
individuals who received services can be broken down by specific demographic categories including age 
range, gender, participant type, incident type, and a combination of race/ethnicity designations.   
After specifying the date range using the From and Through boxes and selecting “Services Provided 
Report,” a screen similar to the one below will appear:   

 
Figure 92 

Services Provided Criteria Screen:  
o Age:  Specify the requested age range. Remember that the age range, like the date range, spans 

the lowest number through the highest number. The age range is equal-to-or-greater-than the 
lower limit and equal-to-or-less-than the upper limit. For example, to display only individuals 
under 18, enter “17” as the highest number.    
 

o Gender: Choose Male or Female. To return all individuals, including those who identify as 
“other,” choose “Both.”  

 
o Participant Type:   Refine the search by filtering based on participant type.  To include all 

individuals regardless of participant type or incident type, select “All.”  
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o Incident Type: Refine the search by filtering based on victim type and incident type.  To include 
all individuals regardless of participant type or incident type, select “All.”   

 
o Race/Ethnicity: Narrow the search by choosing to display individuals who identify as a certain 

race/ethnicity.  To include all individuals regardless of race/ethnicity, select “Show all.”   
 

o “ANY”:    Selecting multiple race/ethnicity boxes and “ANY” indicates that a participant must 
have at least those race/ethnicities selected.  Participants who identify as the selected 
race/ethnicities in addition to other race/ethnicity designations will also be returned.  Use the 
“ONLY” option to contain your search to only the selected categories.  

 
o “ONLY”:    Selecting multiple race/ethnicity boxes and “ONLY” will result in individuals who meet 

ONLY those exact categories and will filter out individuals who have those categories in addition 
to others.  

 
Figure 93 

After selecting the appropriate criteria, select “Create Report.”   To exit the form, select “Close Form.” 
Criteria selections will not be saved.  
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Understanding the Services Provided Report:    
The Services Provided Report will look similar to the figure below:  

 
Figure 94 

o Search Criteria Display: The box at the top displays the search parameters given on the Services 
Provided Criteria Screen. The red oval in the figure above indicates the search criteria.  It is 
always a good idea to double-check that the search criteria displayed matches the search 
criteria entered. In this example, the search criteria given are for females over the age of 18 who 
are classified as primary victims.  No issue type or race is specified.  The results should return all 
adult female primary victims served in the selected reporting period.    

 
o Report Period: The report period is given at the top of the screen.  The blue oval in the Figure 94 

shows that this report is from Jan 1, 2008 through Dec. 31, 2008.   
 

o The Services Provided Report features two columns of numbers to the right of each service 
category. See the green oval in the figure above.   
 

• The left column corresponds to the number of individuals meeting the search criteria 
that received services within the reporting period.  The highest number in left column is 
equal to the total number of individuals served during a reporting period that match the 
search criteria.   
 

• The right column represents the total number of services provided to individuals 
meeting the search criteria within the reporting period.   
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Individual Program Participant Report:  

Purpose:  
The Individual Program Participant Report was created at the request of ANDVSA member programs.  
The Individual Program Participant Report allows users to view an individual record on a monthly basis 
and verify that the data entered matches that individual’s Services Provided form.  It also allows users to 
view the total number of services received by an individual over a selected amount of time.  
  
The Individual Program Participant Report also displays all Program Participant IDs of individuals who 
received services within a given period.  Users can choose to view reports of all services to all 
participants over any period.    
 

 
Figure 95 

After specifying the date range using the data boxes on the Reports Screen and selecting “Services 
Provided Report,” a screen similar to the one below will appear:   
 

 
Figure 96 
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In the Month field, a list of all months within the reporting period in which individuals received services 
will appear. Select an individual month from the drop down menu.  To see services provided for the 
individual during the entire date range, select “All” from the drop-down menu. 
   
In the Participant ID field, all program participant IDs of individuals who received services during the 
selected month(s) will appear in a drop down list.  Highlight a program participant ID and select “Open 
Report” to view that individual’s record for the selected month.  A screen similar Figure 97 will appear:  

 
Figure 97 

In the Figure 97, the total number of services provided to one program participant over a three-month 
period is shown.  The red oval shows the reporting period requested.  Note that when “All” is selected in 
the Month drop-down menu, a sum total of services will be provided.  To see services broken down by 
month, each individual month must be selected and run separately.  
 
To see individual services provided lists for all participants within a reporting period, select “All” from 
the Program Participant ID drop-down menu and click on “Open Report”:  

 
Figure 98 
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Individual reports will be arranged in ascending order.  Navigate among the individual services provided 
reports by selecting the arrows at the bottom of the screen:  

 
Figure 99 

Program Participant & Program Participant with Multiple Incidents Reports  
Enter and beginning and ending date and click the “Program Participant Report” button to access the 
Program Participant Report.  

 
Figure 100 

The Program Participant Report will give the total of unique individuals served within the selected 
reporting period. This number is listed as “Total” beneath the “Gender” category:   

 
Figure 101 
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Explanatory Boxes:  
Throughout the Program Participant report print-out, explanatory boxes like the one below help the 
reader of the report understand how to interpret the numbers.  

 
Figure 102 

Program Participant with Multiple Issues Report:  
This report was created at the request of programs.  Use this report to search for program participants 
who have had more than one incident within a given reporting period.  The report print-out will show a 
list of program participant IDs and the corresponding number of separate and unrelated new incidents 
assigned to each program participant ID.  Remember to widen your search by using the widest possible 
date range.   
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VAWA, FVPSA, VOCA & Training Reports: 
Enter the starting and ending date and click the appropriate button to access the VAWA, FVPSA, VOCA, 
and Training reports.  

 
Figure 103 

 
The VAWA, FVPSA, & VOCA reports collect data based on federal regulations and definitions.  Refer to 
the Program Participant Report for the most accurate demographic data breakdowns.  Use the Services 
Provided Report to see data displayed according to specific search criteria.   
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Accessing Report Pages:  
 

 
Figure 104 

Pre-programmed reports that are longer than one page (VAWA, Program Participant, and Training) can 
be viewed in their entirety by using the page arrows at the bottom of the report screen (see red box in 
Figure 104).  
 
The arrow in the blue box takes you to the first page of the report.  The arrow in the green box takes you 
to the previous page.  The arrow in the purple box takes you to the next page.  The arrow in the yellow 
box takes you to the last page.  

 
Figure 105 
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Printing Reports:  
 

 
Figure 106 

 
All reports can be printed by running the report and then clicking on the File drop down menu (see 
Figure 106). Click on the Print function to print the report.  
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Sending Reports to Microsoft Word: 

  

 
Figure 107 

All reports can be sent to Microsoft Word by running the report and then clicking on the Tools drop 
down menu (see Figure 107).  Click on “Office Links” and then on “Publish It with Microsoft Office Word” 
to send the report to Word.  
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Exiting Reports Section:  
 

 
Figure 108 

Click on the “Close Form” button in the Reports header when you want to exit the reports section of the 
reporting database.  You will return to the opening page (see Figure 109).  
 

 
Figure 109 
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Section Six: Creating Queries  
There are many books available that cover the topic of database queries, Microsoft Access, the 
Structured Query Language, and various other aspects of database interaction.  This section is intended 
to briefly cover some basic concepts that can be used for creating custom reports in the reporting 
database.  
 
To generate a custom report from the data stored in the application database, you will need to become 
familiar with queries and reports.  A query is just a statement that instructs the computer to select data 
and organize it in some fashion.  Reports are used to display the information and also add organization. 
A query can be created without a report and a report can be created without a query. Alternately, a 
query can be created to select very specific information and a report can organize and display the 
selected information.  
 
Queries are written using the Structured Query Language, abbreviated as SQL and typically pronounced 
“Sequel.” Most queries start with the word “select” and follow a structure like this:  
Select * from tblParticipants where Name IS “Andrea”  
 
This statement instructs the computer to Select ALL columns (represented by the Asterisk *) from a 
table named tblParticipants if any records in the Name column match the word “Andrea.”  SQL has 
keywords, such as Select, IS, Like, that are used to determine what records to display and the criteria 
used for selecting those records. 
   
When you want to display and sort all records in the database but only want to show specific columns of 
information, the best tool to use is a standard report.  A report will allow all records from multiple tables 
to be displayed and sorted; however, reports alone are unable to filter the information beyond column 
selection.  The report will display all records present.  When a report is based on a query, the query is 
used to filter and select the necessary records so the report can display only the relevant information.  
 
To access the database directly, browse to C:\ Database and double-click the database_version_10-
07_be.mdb file. This is where all the data that is entered using the “front-end” of the database (i.e., 
ANDVSA_v4.0.mdb) actually ends up, typically refered to as the “back-end” of the ANDVSA database 
(i.e., database_version_10-07_be.mdb) 
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Table View: 

 
Figure 110 

 
This view shows the Tables contained within the database. A table contains columns, such as Name, 
Date, Address, Hours, etc.  Within each table there will also be Records, an entry in the table that 
contains various pieces of information for each column.   
 
All of the information entered in the reporting database will be stored in multiple tables.  To see what 
records and information are stored in a table, double-click the table to view the information.  
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Query View: 

 
 
This view shows Queries that have been created and saved. The Create query by using wizard is the 
easiest way to generate a Select statement that contains the tables and columns needed for a custom 
report.   
 
Once a basic query has been created by selecting the desired columns and tables for display, the SQL 
statement can be viewed and edited directly.  
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Reports View: 

 
 
The Reports view allows you to generate a table of records and sort the table on multiple columns.  For 
instance, a report could be created with all program participants displayed and sorted by last name, 
then sorted by age.  This would create a display with participants in alphabetical order by last name and 
sorted by age for each last name.   
 
When a report is based on a query, the report is used to sort and display the information returned by 
the query.  
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Table Relationships: 

 
To select tables in a SQL statement, the tables must first be Related to each other. You can see which 
tables are related by selecting Tools > Relationships to access the Relationships window. This screen 
shot shows that tblParticipants is related to four other tables in the database; all five of these tables can 
be used in a single SQL statement.   
 
However, unrelated tables cannot be used unless they are first related to other tables.  You should not 
modify the relationships of the database as this can cause the application to stop working. The 
relationships window is just a reference for you to learn which tables can be used in creating custom 
reports.  
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Creating a New Access Database for Queries:  
Queries stored in the back-end of the database will be deleted each time you need to upgrade to a new 
version of the database. Therefore, it is advisable to create a separate database for query storage. The 
following outlines how you can create a database for query storage.  

1. Go to Start > Programs > Microsoft Office and Select Microsoft Access 2003. This will launch 
Microsoft Access.  

 
Figure 111 

3. On the right-side of the application, select the link for Blank Database.   
4. A File New Database window will appear; use the drop-down box to locate the C drive and 

double-click the Database folder.  
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5. Enter a name for the new database, such as query_storage_10-07, and press the Create button.  
 

 
Figure 112 

 
Figure 113 

 
6. Once the database has been created, select File > Get External Data > Link Tables. Locate the 

C:\Database\database_version_10-07_be.mdb file, select it, and press the Link button. Make 
sure the file has “_be” at the end of its name.  

7. In the Link Tables window, press the Select All button and then press the OK button.  
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Figure 114 

 
Figure 115 

At this point, a new database has been created in the C:\Database folder and all the tables from the 
application have been linked. The new database is ready for use; queries can be developed and saved in 
this database without causing any interference in the application’s database.  
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Creating a Basic SQL Query Using the Query Wizard  
1. Open the database file and select Queries from the Objects menu.  
2. Double-click the link for Create Query by using wizard.  
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4. In the Available Fields box, select Participant ID and press the arrow pointing to the 
 right; this will add the Participant ID column to the list of columns in the SQL statement. 
5. Repeat Step 4 for First Name and Last Name.  
6. In the Tables/Queries drop-down box, select tblParticipantServices.  
7.  In the Available Fields box, select Safety Lethality Check and press the arrow pointing 
 to the right.  
8.  Press the Next button.  
9. Verify that the option for Detail (shows every field of every record) is selected and 
 press the Next button.  
10. Give the query a descriptive name, such as Test Query and press the Finish button.  

 

 
Figure 116 

 
Figure 117 
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Figure 118 

 
Figure 119 
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11. The results of the query will be displayed in a window with default sorting.  
 

 
Figure 120 

12. View the SQL statement by selecting View > SQL View.  
13.  This will display the SQL window where the statement can be edited directly.  

 
Figure 121 
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Figure 122 

In this example, the following SQL statement was generated:  
“SELECT tblParticipants.ParticipantID, tblParticipants.FirstName, tblParticipants.LastName, 
tblParticipantServices.SafetyLethalityCheck FROM tblParticipants INNER JOIN tblParticipantServices 
ON tblParticipants.VictimID = tblParticipantServices.VictimID; “ 
 

o After the word Select, the desired columns from each table are named with the following 
convention:  table name.column name  

 
o Multiple columns from multiple tables can be specified by separating each entry with a comma.  

Again, the tables must already be related if they are used in a SQL statement.  
 

o Next, the word FROM indicates which table will be used as the reference.  This is combined with 
the function INNER JOIN; this function looks at both tables and discards any information that is 
not present in both tables. In this example, the FROM and INNER JOIN look at the specified 
tables and determine which records (participants) have Safety and Lethality Checks entered. If a 
program participant does not have this information, then that program participant is not 
displayed.  

 
o Similarly, if there are records for Safety and Lethality Checks that do not have a corresponding 

Victim ID, those records are also not displayed.  The correlating field, Victim ID, is determined by 
the word ON. This function looks at the selected tables and uses the specified column name 
(which exists in both tables) to determine what records in both tables have the exact same 
Victim ID.   
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When this query is run, it will display the Participant ID, First Name, Last Name, and Safety Lethality 
Check information in a new table.  Select Query > Run to display the results of the query statement.  
 

 
Figure 123 

o To modify this statement so it only displays the participants with an actual entry in the Safety 
Lethality Check column, add the following line to the end of the statement just before the 
semicolon:  WHERE tblParticipantServices.SafetyLethalityCheck IS NOT NULL  

 
o The WHERE statement allows you to specify values which must be met for a record to be 

displayed. In this case, the WHERE statement removes any records with a matching Participant 
ID but no data entered in the Safety Lethality Check column. If anything, including a 0 (numerical 
zero), has been entered in the column then the record will be displayed.  To adjust the SQL 
statement so that only records with a Safety Lethality Check of more than zero will be displayed, 
modify the WHERE statement to look like this:   

WHERE tblParticipantServices.SafetyLethalityCheck IS > 0  
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o Now the SQL statement will display all participants who have a matching Participant ID entry in 
the Participant Services table and have a Safety Lethality Check entry that is greater than 0.  

o Finally, the ORDER BY function can be used to sort the displayed information.  For instance, now 
you may wish to alphabetize the entries by last name.  To do this, add another line to the SQL 
statement just before the ending semicolon:  ORDER BY LastName  

 
o This will display the information in an ascending alphabetical list based on the participant’s last 

name.  If a participant has multiple Safety Lethality Check records, this SQL statement will 
display each individual record.  To add an additional level of organization to the displayed data 
so that every participant with multiple Safety Lethality Check records has those records 
displayed in an ascending manner based on the number in the Safety Lethality Check field, 
change the ORDER BY clause to:  ORDER BY LastName, SafetyLethalityCheck  

 
o Now the data will be displayed first, based on the last name of a participant, then organized by 

records for each participant based on the number entered in the Safety Lethality Check column.  
While the information is displayed in a table, all columns and records can be selected and copied 
into Microsoft Excel, if desired, to perform additional calculations or formatting for printing.  

 

 
o Figure 124 

o To move on to the next exercise, remove the ORDER BY clause (leaving the semicolon in the SQL 
statement) and press the Save button to save the SQL statement.  Select File > Close to exit the 
SQL statement window.  
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Creating Queries in Design View:  
1) Write down the criteria for the desired query.   
2) Determine which tables and fields are necessary for creating the query.  
3) Add all the tables to the query in design view.  
4) Add all the appropriate fields to the columns in design view.  
5) Fill in parameters for criteria; this will filter the results based on what is desired from the query 

(i.e. AGE >=18, ServiceDate > 1/31/2006 AND ServiceDate < 3/1/2006).  
6) Select and customize any functions such as Sum, Average, Count, Maximum, etc.  
7) Run the query, verify results and modify criteria if necessary.  

Step 1: Criteria  
After a new Access database has been created and the tables linked, queries can be created for running 
custom reports.  However, before diving into the mechanics of creating a query, the query itself should 
be defined in words and documented for reference.  As an example, a user may want to know “How 
many Caucasian women received services in 2006?”  
This should be broken into criteria statements like:  
 

Gender: female Service Date: Between # 1/1/2006# and # 12/31/2006# Race: Caucasian 
Service: Fully or Partially served  

 
There are a few things that a user must be aware of when creating a query. For Race, the user must 
determine whether being Caucasian and other races is wanted, or if the query should include only those 
who list Caucasian as their only race.  If the criteria for Caucasian is set to “Race_Caucasian = YES” then 
any participant with multiple races that include Caucasian will show up in the query results.  If the user 
requires that Caucasian be the only race listed, the criteria for this field must be set to “Race_Caucasian 
= YES AND Race_Asian = NO AND Race_Black = No…” with every undesired field set equal to NO.  
 
Finally, to determine whether or not a participant received services the user can check the 
ParticipantFullPartiallyServed field.  Using this field is a shortcut to the desired query result; although 
every field for service types could be checked for an entry indicating a participant received that service, 
the ParticipantFullPartiallyServed field is required to be filled-in when a participant receives services.  
Therefore it is sufficient for the query to check this single field instead of the user defining the criteria 
explicitly for each existing service field.  

Step 2 : Determine Necessary Tables 
To start this process, locate the new query_storage_10-07 database that was created and double-click it. 
This will open the database in Access.   
 
In the example from above, the user will need access to Gender, Service Date, Race, and Service 
(Fully/Partially Served).  To locate these fields, the user must open tables directly and search for the 
desired field.  First, select Tables from the Objects menu in Access (by default, Access opens in the 
Tables view).  Locate the Participants table (tblParticipants) and double-click it. 
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Figure 125 

Now the table will be open and the user can scroll through the available fields.  This table contains the 
Gender and Race fields.  
 
Close the Participants table and open the Services table (tblParticipantServices).  Scroll through the 
fields and locate the ServiceDate and ParticipantFullyPartiallyServed fields. Now all of the required 
fields have been located and can be added to the query.   
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Figure 126 

 

Step 3: Add Necessary Tables in Query Design View  
Within Access, select the Queries link from the Objects menu. Double-click the link for Create Query in 
Design View.  
 
This will open a window listing all the linked tables available; to create a query, at least one table must 
be added first. Continuing the example, the Participants table and Services table must be added. Select 
the tblParticipants and press the Add button, then select the tblParticipantServices and press the Add 
button (multiple tables can be selected simultaneously by hold down the CTRL key and clicking on each 
table).  Once the tables are added, press the Close button.  
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Figure 127 

Now all the fields in both tables can be used in the query; whenever necessary, additional tables can be 
added later. 

 
Figure 128 
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Step 4: Add Appropriate Data Fields 
Now that the tables are available to the query, the user must add the appropriate fields.  While in 
Design View with the appropriate tables added, use the drop-down list in the first column for the Field 
row to select tblParticipants.Gender; this will make the Gender field available to the query.  
 

 
Figure 129 

Note: the fields can also be dragged from the tables and dropped onto an empty column to add 
the field to the query, or the user can double-click any field in a table to add it to the query 
automatically.  

 
In the next column, use the drop-down list (or drag and drop, double-click) to add the 
tblParticipantServices.ServiceDate. Now the ServiceDate field will be available to the query.  Continue 
adding fields to the columns until all the required fields for the query have been added.  
 

 
Figure 130 
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Step 5: Fill In Parameters  
Criteria must now be applied to the fields; this will filter the query results and only return the records 
desired by the user.  In this example, the ServiceDate field criteria needs to be specified so only records 
from 2006 are included.   
 
In the ServiceDate column, left-click in the Criteria row and enter the following text:  
>12/31/2005 AND <1/1/2007  
 
Press the Enter key and Access will automatically add the # signs around each date range; a user 
working in the SQL view of a query would need to manually add the # signs.  The date range of the query 
is now set to only include days from 2006.  

 
Figure 131 

Next, select the criteria row in the Gender column and enter the following text: = 1 Press the Enter key.  
 

 
Figure 132 

Because there is a table containing values for gender ( 1 = Female, 2 = Male, 3 = Unknown), the value 
“1” must be used instead of Female.  If a user tries to use the wrong value for this field or other fields, 
the following error will appear when the query is run:  For the criteria row in the Race_Caucasian 
column, this example will assume that any participant who listed Caucasian as race (regardless of 
whether multiple races were selected) will be included in the results.  Enter the following text in the 
criteria field for Race_Caucasian: YES  
 

 
Figure 133 
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Figure 134 

Note: it is also acceptable to use =YES for the criteria.  
 
After pressing the Enter key, no changes will be made since YES or =YES is the proper form of data 
comparison for this field.  
 
Finally, enter the following text in the criteria row for ParticipantFullyPartiallyServed: Is Not Null (this 
means the field has a value entered, instead of a blank value)  
 

 
Figure 135 

Press the Enter key and the text will not change since this is the proper data comparison format for this 
column.  Since the ParticipantFullyPartiallyServed field also uses a separate table with values, it is also 
valid to use the following expression: = 1 OR = 2  
 
In the ParticipantServices table, in the ParticipantFullyPartiallyServed field, a value of “1” corresponds to 
“Fully Served” and a value of “2” corresponds to “Partially Served”.  
 
At this point, all of the criteria for the example query have been entered, so the query should be saved 
before moving on.  Press the Save button and name the query, or select File > Save and name the query.  

Step 6: Customize Functions  
There may be times when a user wants a count of the records instead of a listing of the records.  In the 
example above, the query will return all the records and display them in a table.  To get a count of the 
records instead of the individual records, a function must be added to the query.  
 
Here the user will need to define what the function will be; in a simple case, the user may want to know 
“How many service nights were provided during the year in question?” Since a single participant may 
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have multiple service nights, it would be necessary to perform a SUM on each record from the 
Participant Services table in the Housing field. On the other hand, the user may want to know how many 
individual participants received services during the year in question.  Each of these questions will require 
changes to the query.  
 
To SUM the number of service nights provided in a given year, using the criteria from above:  
 
1. While in Design View, select an empty column and add the Housing field.  

 
Figure 136 

4. In the remaining fields, change the Totals row from Group By to WHERE.  
5. In the Show row, uncheck all the boxes except for the Housing column.  
6. Save the query and run it (Query > Run or  
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). The results will be the number of Housing days provided during the year.  
To modify this query so the total returned is the number of months in which housing services 
were provided during the year in question:  

 
7. Remove the Housing column (click on the gray bar just above the field name; when the 
column turns black, press the delete key).  
8. Add the ServiceDate field in again, so there are two ServiceDate fields.  One column will 
be used to filter the results; the second column will be used to COUNT the number of records 
returned.  

 

 
Figure 137 

9.  On the second ServiceDate column, change the Total row from Group By to Count.  
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Figure 138 

10. Verify the Show box is unchecked for all columns except the second ServiceDate column.  
11. Save the query and run it (Query > Run or  
 

 ). The result should be the total number of months during the year that services were provided 
to participants. If the Housing field were added again with criteria set to IS NOT NULL and the 
Total row set to WHERE for the Housing field, the results would show how many months during 
the year housing was provided to participants matching all the criteria.   
 

 
Figure 139 

Step 7: Run and Verify Query  
Verifying the results of a query can be very important.  Although a query may have been designed and 
executed properly, only through verification can the criteria, functions, and grouping be checked 
thoroughly. One method for testing the validity of query results is to build a new query, similar to the 
original, and test each of the query pieces individually.   
 
Using the example previously outlined, the query could be checked by first determining how many total 
records are returned for the year in question. Then the verification query could be modified to include 
one of the other criteria such as gender. The results with both criteria should have the same or less 
records returned than with only one of the criteria in place.  This method can be used to add each bit of 
criteria, piece by piece, and verify the number of records returned is equal to or less than the number 
returned with only the previous criteria active (the more criteria a user adds, the fewer records should 
be returned).  
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When dealing with COUNT and SUM functions, it can be helpful to export the results into a separate 
application, such as Excel, and perform simple totals on the results.  With only a few of the filtering 
criteria in place, the query results could be opened in Excel and summed in a column  
– such as when analyzing the number of housing nights provided in a year.   
 
Whatever methods are used to verify query results, it is important that at least some steps are taken to 
reasonably demonstrate that what is returned matches the user’s desired output from the database.  

Creating a Report Using the Report Wizard  
Now that a SQL query has been created, a report can be created to display the data for export or 
printing. From the main Microsoft Access window, select the Reports object from the Objects menu on 
the left-side of the window.  

 
Figure 140 

1. Double-click the link for Create report by using wizard.  
2. In the drop-down box, locate the previously created query and select it.  
3. Press the double right-arrows to add all available fields.  
4. Press the Next button.  
5. In the box for “How do you want to view your data?”, select the option for “By 
 tblParticipants” and press the Next button.  
6. In the “Do you want to add any grouping levels?” box, select LastName and press the 
 arrow pointing to the right. Press the Next button.  
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Figure 141 

 
Figure 142 
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Figure 143 

 
Figure 144 

7. On the Report Wizard window, press the Next button. 8. Select the option for Outline 1 
and press the Next button.  
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Figure 145 

 
Figure 146 

8. Press the Next button. 10. Give the report a descriptive name, such as Test Report and 
press the Finish button.  
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Figure 147 

 
Figure 148 

A report will be generated showing the information returned by the SQL statement.  The report is used 
to format the display of the information, group items together, add additional sorting to the 
information, and present a format that can easily be printed and understood.  
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Figure 149 

The test report created here displays all information generated by the SQL statement, then creates 
sections (groups) based on the participant’s last name.  When displayed, the report will have a single 
section for each last name returned; within each section will be the remaining information such as last 
name, Participant ID, and a row for each record in the Safety Lethality Check table.  
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Section Seven: Back-Up Data  
It is important to back-up the reporting database.  Back-ups should be performed once a month.  Below 
are specific instructions on how to back-up the database.  

1. Insert a new, blank CD into the CD Rom.  
2. Close or cancel any dialog boxes that pop-up.  
3. Right-click the Start button and select Explore.  
4. Locate the Database folder on the C drive.  
5. Right-click on the Database folder and select Copy.  
6. Locate the CD Rom drive (should be the D drive); right-click on the drive and select 
 Paste.  
7. The D drive should now be highlighted and the Database folder should be present in the 
 right window pane.  
8. Select File > Write these Files to CD.  
9. Either give the CD a descriptive name or leave it as the default date.  

 

 
Figure 150 
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Figure 151 

10. Check the box for Close the wizard after the files have been written. Press the Next 
 button.  
11. A dialog box will appear, displaying the progress of the CD writing process.  

 

 
Figure 152 
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12. When the process is complete, you can create a second CD with the exact same files.  
 Leave the box unchecked and press the Finish button.  

 
Figure 153 

 
Eject the CD and use a marker to label the CD with today’s date and “Reporting Database.”  Backup CD’s 
should be stored in a secure and locked location as they will contain copies of everything entered into 
the database application.  
 

Backup Note: 
Keep in mind that a backup of the ANDVSA database can also be done by using a USB external hard drive 
by copying the C:\database folder and pasting it onto the USB external hard drive. There are several 
kinds of backup software applications that can perform this action automatically. For more information 
contact the CDVSA Research Analyst. 


	ANDVSA database: General Rules and Information
	Section One: Installing ANDVSA_v4.0
	Final Notes:
	Next Section:
	Section Two: Data Entry & Navigation Techniques
	A word about data entry:
	Required data fields:
	Prompts & Data Field Descriptors:
	Database Navigation Tips:

	Next Section:
	Section Three: Victim Services Data
	Victim Services Data Opening Screen:
	New Program Participant Record: Tab One
	New Program Participant Record: Tab Two
	New Program Participant Record: Tab Three (Incident Information)
	New Program Participant Record: Tab Three (Perpetrator Information)
	New Program Participant Record: Tab Four (Services Provided)
	How to use the Incident Information (Gray Box) on Tab 4:
	Tab4 Incident Information (Gray Box): Important Note

	New Program Participant Record – Tab Five (Protective Orders)
	Searching for Program Participant Records
	Modifying/Adding New Information to Program Participant Records
	Tabs 1 & 2 (Participant Information):
	Tab 3 (Incident Information):
	Tab 4 (Services Provided and Linked Incident Information):
	Tab 5 (Protective Orders):

	Deleting Program Participant Records
	Exiting Victim Services Data Section

	Section Four: Training Data
	Training Data Opening Screen/Tab One
	Training Data Tab Two and Tab Three:
	Training Data Tab Four and Tab Five:
	Searching for Training Records:
	Deleting Training Records:
	Exiting Training Section:

	Section Five: Reports
	Standard Reports:
	Custom Reports:
	Critical Note on “Canned Reports:” (*MAY 2010*)
	Reports Opening Screen
	Services Provided Report
	Purpose:

	Services Provided Criteria Screen:
	Understanding the Services Provided Report:
	Individual Program Participant Report:
	Purpose:

	Program Participant & Program Participant with Multiple Incidents Reports
	Explanatory Boxes:
	Program Participant with Multiple Issues Report:

	VAWA, FVPSA, VOCA & Training Reports:
	Accessing Report Pages:
	Printing Reports:
	Sending Reports to Microsoft Word:
	Exiting Reports Section:

	Section Six: Creating Queries
	Table View:
	Query View:
	Reports View:
	Table Relationships:
	Creating a New Access Database for Queries:
	Creating a Basic SQL Query Using the Query Wizard
	In this example, the following SQL statement was generated:

	Creating Queries in Design View:
	Step 1: Criteria
	Step 2 : Determine Necessary Tables
	Step 3: Add Necessary Tables in Query Design View
	Step 4: Add Appropriate Data Fields
	Step 5: Fill In Parameters
	Step 6: Customize Functions
	Step 7: Run and Verify Query

	Creating a Report Using the Report Wizard

	Section Seven: Back-Up Data
	Backup Note:


